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Warranty Statement 

There are no warranties, express or implied, with respect to the contents of this document, and all information 

provided herein is provided “as is.” Anatomage reserves the right to periodically change the information that is 

contained in this document; however, Anatomage makes no commitment to provide any such changes in a timely 

manner or at all. 

Limitation of Liability 

In no event shall Anatomage or its affiliates be liable to any party for any direct, indirect, special, or consequential 

damages in connection with your use of this document, including, without limitation, loss of business revenue or 

earnings, lost data, damages caused by delays, lost profits, or a failure to realize expected savings, even if 

Anatomage was expressly advised of the possibility of such damages. 

End of Life Statement 

InvivoLight software is dependent on its hardware requirements. The life-cycle is limited only by the availability of 

the required hardware. 

Trademarks 

Anatomage and related marks, images, and symbols are the exclusive properties of, and trademarks of, Anatomage 

Inc. All other brands and marks are the properties of their respective owners. 

Copyright 

Documentation for InvivoLight and the operating software are copyrighted with all rights reserved. Under the copyright 

laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human or computer 

language in whole or part without the prior written permission of the copyright holder. 

Intended User 

 

InvivoLight is designed to be used by medical and dental professionals who have been appropriately trained to 
use 3D CT imaging devices and read the image data generated by the devices. 

Caution:  Federal law restricts this device to sale by or on the order of medical and dental clinicians. 

Indications for Use 

InvivoLight is a software application used for the display and 3D visualization of medical image files 

from scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by radiologists, 

clinicians, referring physicians, and other qualified individuals to retrieve, process, render, review, store, 

print, assist in diagnosis and distribute images, utilizing standard PC hardware. Additionally, 

InvivoLight is a preoperative software application used for the simulation and evaluation of dental 

implants, orthodontic planning, and surgical treatments. 

 

This device is not indicated for mammography use.  
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Introduction 

InvivoLight Imaging Software 

natomage, Inc. is a medical imaging company composed of  
a cross functional team consisting of  the most elite 
researchers, mathematicians, engineers, software developers, 

business analysts, industry leaders, academic faculty, and dental 
specialists.  We believe that InvivoLight software will enable the 
profession to initiate a revolution of  unimaginable scope and 
magnitude.   Ultimately, our mission is dedicated to developing 
software specially designed for dentists to be simple and refined, yet 
utilizing the most advanced cutting edge software and technology to 
better serve their patients.  With InvivoLight software, doctors can 
create 3D volume renderings on their own computers, get cross-
sections, trace nerves, place implants, print images, save images, and many more functions.  The software is 
designed to reconstruct these 3D volume renderings from DICOM files generated by CBCT, Medical CT, and 
MRI radiography machines. InvivoLight is intended for use as a planning and simulation software in the 
placement of  dental implants, orthodontics and surgical treatment. 

his manual is intended to provide supplementary information to your direct training with the Anatomage 
support team. For correct and safe use, training is available to all InvivoLight users and is highly 
recommended. For more information, please contact the Anatomage customer support team at (408) 

885-1474 or email info@anatomage.com 

 

A 

T 
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using InvivoLight efficiently and generating the 
highest quality images possible for enhanced analysis and presentation for your patients and colleagues. 
The most important element is the video card (3D graphics chip or GPU).  If  your system does not 

have an appropriate video card, you can purchase and install video cards for desktop computers. 

InvivoLight has minimal system requirements; however, Anatomage recommends the following configurations to 
fully utilize all the features within the InvivoLight Software. The following recommendations have been updated in 
May 2015: 

Summary 

 Minimum Recommended 

CPU Pentium 3 
Intel Core i7 4000 series or comparable multi-

core processor 
RAM 3GB 4GB 

GPU / Graphics Card 
ATI Radeon HD 4650 or Nvidia GeForce 

9800 GT 
ATI Radeon HD 6800 or comparable 

Hard Disk 100 GB 500 GB 
OS Windows 7 32-bit Windows 7 64-bit or Windows 8 64-bit 

 

Mac Users 

 
OS Hardware 

Not Compatible Apple OS, Parallels MacBook Air, Mac Mini 

Fully Compatible 
Apple Bootcamp (requires a full license of 

Windows) 

iMac, MacBook Pro (15in), Mac Pro 
Note: Please check if a dedicated graphics card 

(Nvidia/Radeon) is included. 

 

Graphics Cards / GPU Details 

Brand Model Series Low-End Options Recommendation High-End Options 

ATI 
Radeon HD 4600 – 

R9 290X 
Radeon HD 6450 

Radeon HD 6800  

series 
Radeon HD 7970 

Radeon R9 290X 

Nvidia 
GeForce GT 430 –  

GeForce GTX Titan 
GeForce GT 635 

GeForce GTX 645 
GeForce GTX 650 

GeForce GTX 760 
GeForce GTX 660 Ti 

 

  

H 
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Laptop Recommendations 

IMPORTANT: Ensure the laptop has a dedicated video card. Integrated graphics cards alone, such as Intel HD 
Graphics, are insufficient for 3D rendering. 

Note: Graphics processor options may vary. Please check with the laptop manufacturer for details on graphics processor options. 

Dell  

Sizes Model Series Graphics Processor Options Weight 

11'', 14'', 
17'', 18'' 

Alienware M 
Nvidia GeForce 765M 
Note: Known issue with new GT 700M series drivers; will only work 

with “Nvidia driver 311.48.1.3.24.2” as of 1/29/2014 
4.4 – 11.7 lbs 

15'', 17'' Inspiron R ATI Radeon HD 8850M or Nvidia GeForce GT 750M 6.1 - 7.3 lbs 

15'', 17'' Studio XPS Nvidia GeForce GT 730M or GT 740M or better 5.8 - 7.4 lbs 

HP (Warning: HP brand laptops have a known issue with switchable graphics. A BIOS update from the HP website may be necessary to run Invivo5 with 

the intended graphics hardware.) 

Sizes Model Series Graphics Processor Options Weight 

15'', 17'' Envy ATI Radeon HD 8750M or Nvidia GeForce GT 750M 5.6 – 7.5 lbs 

15'', 17'' Pavilion ATI Radeon HD 8670M 5.5 - 6.6 lbs 

 

 
For additional information, recommendations or assistance, please contact the Anatomage Tech Support 
Department at (408) 885-1474 or email info@anatomage.com 
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Installing InvivoLight 
InvivoLight Setup Wizard 

Before proceeding, please ensure the computer is connected to the Internet. InvivoLight Setup will check for 
certain components that are important to the performance of  the software. A result of  Pass or Fail will be 
provided as the components for that computer are compared to a list of  the most compatible components. A Fail 
result will not prevent the installation from completing and is only intended as a warning of  the possibility of  
suboptimal software performance as a result. 

 

OpenGL Vendor: Associated with the 
manufacturer of  the graphics processor 

OpenGL Version: Associated with the 
driver version of  the graphics hardware 
component 

Memory: The quantity of  RAM installed 
on the motherboard 

 

Click Next to continue. 

 

 

Enter the numerical authorization code. If  
you have an alphanumeric license key, click 
Advance and put in the key in the blank 
provided. 

Click Next to continue. 
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This window allows you to change the default 
installation folder. 

Click Next to continue. The program will 
proceed with installation until completed. 
Clicking Finish will close the wizard. 

 

 
 
Validating the Installer File 

 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 

The following pictures are for example purposes only. The name of  the installer and Digital Signature Information is dependent on the 
release version and may change accordingly.  
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Feature List 
An overview of  the various features provided by InvivoLight. 

 

• Directly Opens DICOM Data from Any CT Machine 

 

• Invivo File Compression 

 

• Section and Multislice View Operations 

 

• Volume Rendering of Scan Data 

 

• Linear, Angular, Circumferential, and Area Measurements* 

 

• Image Capture and Export 

 

• AVI (Movie) Capture and Export 

 

• Implant Treatment Planning 

 

• Restoration and Abutment Visualization 

 

• Bone Density Evaluation 

 

 

 

 

 

 

 

 

 

 

 *All measurements are performed with the metric system. 
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Software Layout 
The following is a description of  how InvivoLight is organized by Menu Bar, Tool Bar, View Tabs, View 
Controls, and Rendering Window. 

 

 

 

 

 

 

 

  

View Control 
View Control is the region 
where patient images can be 

manipulated and controlled.  The 
View Control is associated with 

a specific View Tab. 
 

Rendering Window 

Rendering Window is the region 
where patient images are 

displayed.  This window can be 
customized within many of  the 
View Tabs by using the Toolbar. 

View Tabs 
The View Tabs allow 
you to perform specific 
tasks or look at specific 
subjects of  interest by 
adjusting the Toolbar 
and View Controls 

Menu Bar 
The Menu Bar 
allows you to 

perform application 
operations such as 
open, save, close, 
print, capture, etc. 

 

Toolbar 
Tools can be accessed to 

perform certain functions on 
patient images.  Sets of  tools are 
associated with a specific View 

Tab. 
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InvivoLight Preferences 
This section will explain the different options within the Preference window of  InvivoLight. The InvivoLight Preferences 
include options for Display settings, Volume Rendering settings, as well as File Manager settings. 
 
Accessing the InvivoLight Preferences: 

• In the Menu bar of  the InvivoLight, select “File”.  

• Select “Preference…” from the “File” drop-down. 
 

Display Preferences 

 

GUI Settings 

• Background: Sets the background color for 
the Rendering Window 

• Measurement Font Size: Sets the 
measurement font size to a size preset: 
small, medium, or large 

• Measurement Text Color: Sets the text 
color for measurement notations 

• Tag Text: Provides an additional label to 
the right hand corner of  the rendering 
window 

• Date Format: Current date format for case 
information display 

• Continuous View:  
o Checked – Switching between view 

presets for volume renderings will 
show intermediate volume positions  

o Unchecked – Switching between 
view presets will not show 
intermediate positions – the volume 
will “jump” to the final position 

• Make Text Annotations Global: when 
checked, previously placed or new text 
annotations added to any 2D slice view 
except group slices (ArchSection) will be 
visible when scrolling past the slice the 
measurement was placed on 

 
 

• Cycle 2D Distance Measurement Color:  Measurement colors will cycle with every measurement 
that is added 

• Enable Multiple Distance Measurement Mode: Distance Measurement will become a toggle on/off  
button for measurement mode. Toggling “on” this mode will continue to pick beginning and end 
points for linear measurements with each click after the first measurement has been created 
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Default Image Sharpening 
This drop-down menu features three settings: No Sharpening, Mild Sharpening, and Hard Sharpening. 
This setting determines the amount of  sharpening applied to 2D grayscale and 2D X-ray (pano and 
ceph) images universally. Changes will occur immediately without restarting the program and the 
specific setting can still be changed manually in each individual tab. 
 
Tabs 
This section determines which View tabs are seen by the user when the program is running. Checked 
boxes will be available while unchecked boxes will hide those View tabs. Changes are made after 
restarting the program. 
 
Auto save 2D view setting on application exit 
This setting will determine if  2D view settings made in each of  the applicable tabs will be saved 
automatically upon program closure and be reloaded with the next opened case. If  left unselected, the 
user will have to manually save the configuration by clicking Save View Settings in the working tab. 
The specific 2D view settings that will be saved in each tab is given in the table below: 
 

Implant Layout, Restoration Lock, View Preset, 
Brightness/Contrast, Sharpen Filter, Volume 
Clipping, and Remove Crown 
 

ArchSection Slice Interval, Cross Section 
Width/Interval/Thickness, Auto R-L, Pano Image 
Type, Pano Ruler Enabled, Brightness/Contrast 
mode, Layout (including Axial vs. Cross Series and 
Print Layout), Sharpen Filter, Color Preset, Nerve 
Diameter, and Nerve Visibility 
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Volume Rendering Preferences 

 

Volume Rendering View Settings 

• Quality Resolution: Sets the limit for the 
resolution of  the image. This can be set to 
either a user-defined number or set to 
Unlimited. 

• Init (Initial) Rendering: Sets the rendering 
quality upon opening InvivoLight. 

• Shaded Slice Sampling Rate: Accepts a 
numerical value that sets the sampling rate 
to improve image quality at the cost of  
performance. 

• Use lower resolution while moving volume: 
positional changes of  the volume will be 
rendered at a low quality resolution while 
maintaining the quality resolution setting in 
the final position. 

Volume Rendering Range 

• The user can define the range of  
Hounsfield Units that will be rendered. 
This cannot be set when “Use Automatic 
H.U. Range” is checked.  

• Checking “Non-CT Modality Use Scalar for 
Min-Max” will allow the user to define the 
Min and Max Scalar units that will be 
rendered. 

 
 

 
Material 

• Various properties can be adjusted to change the appearance of  a volume rendering. Ambient, 
Diffuse, and Specular effects can be rendered in different colors. 

• The degree of  Emission and Diffuse can be adjusted with the respective slide bars. 

• Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 

File Type-Associated Folder Paths 
Folder paths can be set for each of  the Invivo and DICOM file type options. When one mode is selected, 
the program will use the file paths associated with that file type mode, but the user may still save or open 
either file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer with InvivoLight installed across multiple 
user accounts, the file paths for all new accounts will initially take on the preferences defined by the user 
administrator account. Non-admin accounts may redefine their file path settings but they will be overwritten 
the next time the settings are changed on a user administrator account. 
 

 

File Paths 

• Anatomage Case Path: Starting the 
program will open a window showing a 
list of  cases within this location. 
o Can also serve as a backup 

folder for all opened cases. 

• Default Open Path: This is the starting 
location for attempting to open a case 
through File → Open in the Menu bar. 

• Default Save Path: This is the starting 
location for saving a case file in 
InvivoLight. 

 
Copy Files to Anatomage Case Folder 
Before Open 

This section allows the user to save a 
copy of  a case that is to be opened in 
the Anatomage Case Folder if  it is in 
any location besides this folder, such as 
on a different location on a network, 
on a CD-ROM, or in a different folder 
on the local hard drive. 
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Basic Features 
The following is a detailed explanation of  the various features provided by InvivoLight. 

DICOM & Invivo File Loading with the File Manager 

  

To open a DICOM data set or Invivo-associated file type (.inv, .amg, apj), first launch the InvivoLight 
software. The File Manager will appear upon startup, allowing you to open the data. 

 
  
Click the Browse File button to 
manually search for the data you 
would like to open. If  you are opening 
DICOM data, as shown to the right, 
simply highlight one of  the .dcm files 
and click Open. It does not matter 
which DICOM file you choose, just 
click one and the software will open 
all the files within the data set present 
in that folder.  If  you are opening an 
Invivo file just click it and press 
Open. Invivo files can be compressed 
and opened. 
 

 

 



I N V I V O L I G H T 5 . 4
®
 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

 

ANA003 Rev D.  14 June 2017                                           Page 17 of 61                                      UM-INVL-ENG-54D 

The File Manager allows you to automatically store and reopen recently viewed cases. This allows for 
quicker access to cases. By default, files will be saved in the “Anatomage Cases” folder, located in “My 
Documents.” This location can be changed in the Menu Bar → File → Preferences → File Manager. 
 
 
InvivoLight allows you to quickly 
search through your recent cases by 
typing in the Patient Name or Scan 
Date in the search fields (shown 
right).  You can also remove the 
selected Recent Cases from your 
Recent Case List by selecting the 
Options... button and using the 
additional boxes (shown below).  
This will also allow you to 
completely clear your Recent Case 
List. 
 
 

 

If  you close a case and want to reopen another one, click on “File” → “Open” and the File Manager will 
appear again. 
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Invivo/DICOM File Saving 

InvivoLight provides four options for saving and each type 
differs according to the size of  the saved file and its 
compatibility with other software. Choosing “File” → “Save 
As...” for any file will present the dialog on the right. Choosing 
“File” → “Save” when a DCM file is open will save an INV in 
the specified location or simply overwrite the same file it is of  
the INV file type.  

 
Invivo 

The following work can be saved as an Invivo file 
(.inv).   

• Case Information & Patient 
Orientation 

• Traced Nerve Pathways 

• Implants & Implant Measurements 

• Landmarks and Annotations 

• Images captured within the Gallery 

Click “File” → “Save As...,” browse to the 
folder you would like to save, name the file 
(default is the patient’s name), then click Save. 
 
The following save dialog box will show up. 
Select the default “Full” option for saving 
everything without losing any information. 
  
DICOM  
When the DICOM file type is chosen, the output 
options will be a either a single lossless DICOM 
or multi-file DICOM (with DICOMDIR) 
accompanied with an Invivo workup file 
containing workup data and a folder of  exported 
Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save 
dialog will ask for a location to save the files. For 
multi-file DICOMs (Figure 2), you will have to 
create or choose a folder to save the slices and 
DICOMDIR file. The DICOMDIR file presents 
the directory of  slices to InvivoLight to accelerate 
the loading speed. 
 

 
Figure 1: Single-file DICOM Save Dialog 
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The DICOM File Save Option dialog (Figure 3) will present numerous options for saving the file. 
Compression will reduce the size of  the file (at the cost of  increased saving and loading speed), 
Lossless or Lossy determines the quality (amount of  data) of  the file that is saved, and resampling will 
change the resolution by a factor in each orthogonal plane. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 

Figure 3: DICOM File Save Options 

 

Custom Saving Dialog 

Available for Invivo file saving: By selecting the “Customize” 
option, the custom saving dialog shows up. In the dialog box, 
one can compress the data. For the main volumetric image, you 
can select to save it as “LossLess” or “Lossy” compression. With 
LossLess compression, the volume is compressed to about 
1/3rd – 1/4th of  the original size. With the Lossy compression 
option, the file size can be dramatically reduced, but the image is 
altered. Resampling the data will reduce its size very dramatically 
by combining voxels to reduce the overall voxel count. Rescaling 
the image will reduce the number of  shades of  gray in the image. 
You can also choose to selectively compress images in the gallery, 
the clinical content (such as implants and nerve tracings), and the 
models. 

 
 

Saving As an Invivo Project File 

Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file will only save changes 
made to the original scan data.  It requires a reference data (.dcm scan data or .inv file) when opening.  If  
InvivoLight cannot locate the reference data, it will ask you to locate the data again. Because it is saving only the 
changes to the original, APJ files save much faster than full INV files. 
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Lay Egg 

This function will create an executable file containing the 3D volume data from the scan that is currently open as 
well as a 2D Invivo viewer program. This function is designed to allow the sharing of  scan data from an 
InvivoLight user to a non-InvivoLight user on shareable media such as a CD, DVD, or flash drive. Note that some 
antivirus programs may detect the file as a virus due to its executable format. 

EggViewer: Running this file will 
initialize the viewer program and then 
load the embedded scan data. The 
EggViewer contains some Section, 
ArchSection, and Gallery functionality  

                

Export to CD 

This function will export the currently opened scan as a compressed or uncompressed DICOM or a full, 
compressed, or customized setting Invivo file. The exported image file will be placed in the temporary burn 
location in the computer.  
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Case Information Display 

To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize 
then click OK to save the changes. For safety, only the patient's name or “Anonymous Patient” can be displayed 
and cannot be manually edited. 

   

 

 
 
 

Image Capture to File 

To capture an image of  the active display click “View” → “Capture to File.” Browse to the location where 
you want to save the image, type the name of  the file, choose the file type on the “Save as type” drop-down, 
and click Save. The file can be saved as bmp, jpg, or png format. Jpg is the most popular file format for 
images, but there is a small amount of  color degradation. Bmp preserves the image, but the file size is big. 
Png is an effective lossless format that does not degrade the color. 
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Image Capture to Gallery 

Selecting “Capture To Gallery” will capture an image of  the rendering window and save it to the Image List (see 
Gallery Tab features for additional information). 

 

 

Image Capture to an Email 

Selecting “Capture To Email” will capture an image of  the rendering window and attach it to an email ready to 
send. This tool requires e-mail client setup before use (ex: Microsoft Outlook, Mozilla Thunderbird). 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard and mouse. 

 

Slider Bar Scroll  

 
 

• Click the mouse cursor over any slider bar (e.g. axial slice, brightness, etc.) and move it to adjust the image. 

• Click the slider and keep the mouse cursor in the Control Panel before scrolling the mouse wheel forward or 
backward to achieve the image adjustment you like. 

 
 

Zoom In/Out 

• Place the mouse cursor in the center of  the image you want to 
zoom. 

• Hold down the “Control” key + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse 
up and down on the screen. 

• This shrinks/enlarges the image: Down vertically zooms out. Up 
vertically zooms in. 

 
 
 
 

Pan (Shift) 

• Place the mouse cursor in the center of  the image you want to shift. 

• Hold down the “Shift” key + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse any direction 
to achieve the desired image displacement. 
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Free Rotate 

Applicable only for 3D images.    
 

• Place the mouse cursor in the center of  the image you want to shift. 
Hold down the left-button on the mouse. 

• While holding down the left-button, move the mouse in any direction 
to achieve the desired rotational position. 

 

 

 

Free Rolling 

• Hold down the “Space” key  + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse up 
and down to rotate the image about a central axis. 

 
 
 

 

Increment Rotate 

Applicable only for 3D images.    

• Use the keyboard arrows ←←←← ↑↑↑↑ ↓↓↓↓ →→→→ to rotate the 3D Model 1 degree up, down, right, or left., perpendicular to 
the computer screen. 

 
 
 
 

Increment Roll 

Applicable only for 3D images.    

• Hold down “Control” and use the keyboard arrows ←←←← →→→→ to rotate the 3D Model 1 degree rolling left or 

right about a central axis. Pressing ←←←← →→→→ without the Ctrl key pressed will roll the image left or right. Use ↑↑↑↑ 

↓ ↓ ↓ ↓ to roll the image up or down.  
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Anatomical Plane Clipping 

Applicable only for 3D images.   
 
 

• Place the mouse cursor over the center of  the image, then scroll 
the mouse wheel forward or backward to clip the anatomic plane 
as you like (after enabling clipping in the Control Panel). 

 
 
 
 
 

Scroll Slice 

Use when you would like to move through the series of  sections when in either 
the Section, ArchSection, or Pano views.   

• Place the mouse cursor in the center of  the image then scroll the mouse 
wheel forward or backward to move one section at a time as you advance 
through the data slices. 

 
Note: In the ArchSection Tab, you must first create an arch spline to activate this feature.   
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Full Screen Mode and Keyboard Shortcuts 
Below is an explanation pertaining to running the software in full screen mode without toolbars and controls. 

Switching to Full Screen Mode 

From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo 
display system.  To return back to the normal screen mode, press the “Esc” key on the keyboard. Full screen is not 
applicable to the ArchSection Tab and Implant Tab. 

Keyboard Shortcuts at Volume Rendering View 

The following keyboard short cuts are available in Volume Render view: 

Category Keyboard Shortcut Description 

View Preset 

1 Inverse Volume Rendering 

2 Soft-Tissue 1 

3 Soft-Tissue 2 

4 Soft-Tissue + Bone 1 

5 Soft-Tissue + Bone 2 

6 Teeth 

7 Bone 

8 (unassigned) 

9 (unassigned) 

0 Gray Scale 

Clipping Control 

P Toggles clipping plane on/off 

A Axial clipping set 

S Sagittal clipping set 

C Coronal clipping set 

F Flip the clipping direction 

Page Up / Page Down Move the clipping plane 

Copy/Paste Ctrl+C/Ctrl+V 
Text/Circle/Arrow notations can be copy 
and pasted  

Delete Del 
Pressing this key will delete the selected 
measurement, comment marker, notation, 
airway volume, or nerve 
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The View Tabs: 

ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of  conventional X-Y-Z sections, this view allows the user to 
review the image in dentally meaningful perspectives using multiple cross sections, traversing the lengths of  the dental arches. 
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ArchSection: Toolbar 

Shown below is the Toolbar and tools that are loaded with the ArchSection Tab: 

  

 
Reset View: Resets the window to the original view. 

 

Create Arch Spline (Focal Trough): After selecting this tool, you can create a new arch spline or 
edit an existing arch spline. First, left-click on the point you would like to start and continue adding 
points by left-clicking. After you have marked your final point, right-click or double-click to finalize 
the arch spline. When modifying an existing arch spline, drag the control points to the desired 
positions. 

 
Arch Spline (Focal Trough) Ruler: Places ruler along the arch spline for easy reference. 

 

Distance Measurement:  After selecting this tool, click two points to mark the desired distance. A 
number in millimeters will automatically display. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them will appear. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it.  

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
will be automatically display. Click on the measurement and press the “delete” key to delete it. 

 

Polygonal Measurement: When selected you may mark an unlimited number of  points on the 
volume and the total between the first point and the last point will appear. Right-click your mouse to 
indicate that you have marked your last point. Clicking on the point and moving the cursor can 
modify points. Click on the measurement and press the “delete” key to delete it. 

 

Layout: Creates a different layout to your preference. After clicking on the layout icon, a list a 
various layout options will appear. Click on the layout of  your preference to apply it. These options 
allow for different case workup images. 

 
Show/Hide Implant/Cursor/Nerve: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

View Sequence:  Allows for the creation of  custom camera sequences and AVI file movie 
capturing.  

 

Slice Capture Mode: Disabled; this feature is available with the add-on Report module for 
the full Invivo5 software. 

 

Select Region: Calculates the HU value of  an area within a bounding box. The measurement 
values will display alongside the rectangle and can also be by dragging. 
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Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well defined. The apparent boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must 
understand the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or 
software problems with measurements, or have further questions or concerns about using measurement tools correctly, 
please contact us at (408) 885-1474 or email us at info@anatomage.com 
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ArchSection: Control Panel 

 

Layout: 

• “Screen” layout is optimized for viewing the image on 
the computer screen. “Print Out” layout is optimized 
for printing the image on paper. With Print Out layout, 
what you see on screen will be printed on the paper in 
life-size. First, capture to Gallery, then print from 
Gallery to ensure the image is life size. 

• Change Layout allows you to adjust the layout with 
different amounts of  slices and orientations. 

Vertical Range and Orientation: 

• “Adjust Range and Orientation” will switch to a mode 
allowing for the adjustment of  the upper and lower 
limit of  pano and cross sections. You can also reorient 
the image in this view. 

Cross Section: 

• Width: Cross-section width. 

• Interval: Distance between the subsequent cross 
sections. 

• Thickness: Allows for the cumulative thickness of  the 
slices to be viewed in the cross sections. 

• Auto R-L: This will allow the cross section to be 
oriented to a consistent R-L orientation on screen. If  
turned off, the cross-section orientation will be 
consistent to arch spline. 

Panoramic Image: 

• Slice mode will show you a single cross section along 
the panoramic curve (yellow). 

• X-ray will show you the ray sum (reconstructed x-ray) in 
the focal trough. Slice mode is used for drawing the 
nerve. 

• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans taken by 
a i-CAT© Cone Beam 3D system. (This setting is only displayed in the Control Panel when a Tru-
Pan™ case is currently loaded.) 

View Control: 

• Brightness and Contrast allow you to adjust the image. 

• The All drop-down allows you to adjust brightness/contrast in different areas independently. 

• Different Color Presets can be used to view the images in color. 

• Sharpening Filter applies the selected sharpening filter from the drop-down menu to the 2D slice 
renderers. 
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Nerve Pathway: 

• New Nerve: Starts a new nerve tracing 

• Modify: Allows editing of  the selected nerve tracing. 

• Visibility: Controls the visibility of  the nerve in the section and X-ray renderers. 

• Nerve Node: Select a specific node for modification. 

• Diameter: Selects the diameter of  the nerve that has been traced or a specifically selected node. 

• Delete: Deletes the last placed node during the tracing or the entire nerve if  Modify is active. 
 

 Save View Settings 
Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 12) for more information on which settings are saved for this specific tab.  
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ArchSection: Creating a Nerve Pathway 

Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 

• Click New Nerve. 

• Left-click the mouse where you want the nerve to start. 

• Move the mouse to the next point along the nerve path and left-click again. 

• Click Delete to remove the last-placed node if  it is mispositioned. 

• Repeat this procedure for the entire length of  the nerve. 

• 2.0mm is the default diameter of  the nerve pathway, but you may adjust it for your preference. 

• Press Done to finish. 
 
Editing a Nerve Pathway 

• Click on a nerve tracing to select it. This highlights it in a brighter red color. 

• Set the Nerve Node drop-down menu to “All” or a specific node.  

• If  “All” is selected, the entire nerve tracing’s diameter can be adjusted. 

• If  a single node is selected, it will be highlighted in the scan, and its diameter and position may be adjusted 
independently. The nerve node diameter is adjusted in the Diameter drop-down menu. The highlighted node 
can be moved by clicking and dragging it across the scan. 

 
Deleting a Nerve Pathway 

• The Delete button can be used if  a point was plotted in the wrong spot; it will delete the last point added. 

• Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and 
pressing the “delete” key on the keyboard or the Delete button. 

• Visibility will turn the nerve on or off  from view. 
 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off  of the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software problem with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Anatomage support at (408) 885-1474 or email 
us at  info@anatomage.com 
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators.  These ArchSection coordinate 
indicators show where you are spatially located within the ArchSection modeling window. 

• Cross Section Indicator: The green lines give the location of  the cross sections along the arch spline.   

• Axial Slice Indicator: The orange line shows the axial coordinate position within the section.   

• Arch Spline: The brown spline in the center of  the arch spline represents the current position where the arch 
section has moved. 

• Cross Section: Mouse scrolling within any one of  the three sagittal frames advances the slices to the patient’s 
right or left and causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano 
sections simultaneously. 

• Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and 
causes the red coordinate indicator to move superiorly or inferiorly in the cross or pano sections 
simultaneously. 

• Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes 
the brown coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                                                     



I N V I V O L I G H T 5 . 4
®
 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

 

ANA003 Rev D.  14 June 2017                                           Page 34 of 61                                      UM-INVL-ENG-54D 

Implant View Features 
The Implant View Tab allows you to access the full-featured implant planning module. 
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Implant: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Implant View Tab: 

 

 
Reset Views: Resets the Rendering Window to the original view. 

 
Left View: Automatically orients the volume so the patient is facing left sagittal. 

 
Left ¾ View: Automatically orients the volume so the patient is facing 45° left sagittal. 

 
Front View: Automatically orients the volume so the patient is facing the front. 

 
Right ¾ View: Automatically orients the volume so the patient is facing 45° right sagittal. 

 
Right View: Automatically orients the volume so the patient is facing right sagittal. 

 
Top View: Automatically orients the volume so you are oriented above the patient 

 
Bottom View: Automatically orients the volume so you are oriented below the patient. 

 
Back View: Automatically orients the volume to the posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will 
appear. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it.  

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them will appear. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it.  

 

Insert Implant: To place an implant, first click the Add Implant icon, select the Tooth ID for the 
implant, then left-click the mouse on the spot that you want the implant to be placed. Note: specific 
manufacturers measure the implant from different points, so a measurement in the software might 
not be the same as the actual measurement of  the specific implant design. 

 
Show Implant Angle Dialog: Opens a window displaying all the angles between placed implants. 

 

Change Layout: Toggles the rendering window layout. 

 

Create Summary: Creates an Implant summary of  images that is added to the Gallery. Images 
contain ID (FDI), implant product, diameter, and length information in the lower right hand corner 
of  the screenshot. The user will also be given an option to print a reference chart which lists the 
implants placed (including implant site, manufacturer, product name, diameter and radius) for each 
arch. 

 

Toggle Grid: Toggles between two different grid layouts for use in the upper two section frames 
allowing quick assessment of  measurements and spatial location. 
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Toggle Move Widget: Toggles the implant orientation widget on and off. 

 

Information Display: Displays or hides case information embedded in the data. 

 

Change Model Visibility: Allows various models to be turned on or off  from view. 

 

Treatment Lock: Locks the implants in place so that they are not accidentally moved when 
viewing the 3D images. 

 

Preferences: Allows you to adjust the different rendering, color and visibility preferences. 

 

Density Profile Control: Adjust the settings for the displayed density profile around planned 
implants. 

 

Check Sleeves: The program will search for collisions between the sleeves, instruments, and stone 
models. 

 

Generate View  Sequence: Disabled; this feature is available in the full Invivo5 software. 

 

Visualize Bone Graft Volume: Simulates a bone graft near the apex of  an implant and displays its 
volume. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast 
setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 885-1474 or email us at info@anatomage.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problem with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 
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Implant: Control Panel 

 

Add Single Implant: 

• Click to add single implant to the 3D volume. 

• Adjust the implant orientation and placement using the 
move widget that appears on the selected implant. 

Planning Layout: 

• 3D Implant: Place and adjust individual implants on 3D 
volume. 

• Pano Implant: Add multiple implants using the Pano view; 
select “3D Implant” to exit Pano view and re-adjust 
individual implants. 

• Restoration: Disabled; this feature available in the full 
Invivo5 software. 

Restoration: 

• Lock to Implant: When selected, the implant and 
restoration will move as a single unit. 

• Add All: Disabled; this feature is available in the full 
Invivo5 software. 

• Remove All: Disabled; this feature is available in the full 
Invivo5 software. 

• Edit: Disabled; this feature is available in the full Invivo5 
software. 

View Presets: 

• Setup: Opens a dialog where the view presets can be 
configured. 

• Presets: Preset toggles that display the selected features as 
configured in the Setup. 

• Upper/Lower: Toggles the visibility of  the stone models 
if  present. 

Volume Rendering: 

• Rendering Types: Different settings allow for better 
visualization of  certain anatomic structures, soft tissue 
profiles, hard tissue, etc. This is achieved by displaying 
specific densities with specific colors. 

• Brightness & Contrast: Can be adjusted for each of  the 
presets to enhance your image. 

• Visible: Allows the 3D Volume Rendering to be turned on or off  from view. 

• Remove Crown: Only applicable with surgical guide related modeling service options. 

• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans 
taken by a i-CAT© Cone Beam 3D system. (This setting is only displayed in the Control Panel 
when a Tru-Pan™ case is currently loaded.) 

• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D 
slice renderers. 
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Clipping: 
Click the “Enable Clipping” box to slice the image along the predefined Anatomical Planes (sagittal, 
axial, coronal, and arch).  Scrolling the mouse wheel or moving the slider bar will move the clipping 
plane. To switch a view to the opposite side, click “Flip.” 

Implant: 
The implant section can be configured to only show specific implants as defined by the user. For more 
information,  look at the Preferred Implant settings further in this section. 

• ID: Use the drop-down menu to select an implant to manipulate. The active implant will appear 
lighter in color than the others. 

• Manufacturer, Product Name, Diameter, and length: The default is generic, but you may select a 
specific implant manufacture, diameter and length. 

Save View Settings 
Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 12) for more information on which settings are saved for this specific tab.  
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Implant: Rendering Window 

 

Used for more precise control and final detailed touches to implant treatment planning.  Using the navigation 
discussed below, you can visualize all aspects of  the implant in the 3D volume. For further information on implant 
position and sizing using the implant widgets, please refer to the next section of  the manual.  Once an implant is 
added, it will also appear in the Volume Render View. 

Axial Section:  Top left window. This section is the view from the top of  the implant. The yellow line passing 
through the axis creates the view seen in the sagittal view. Scrolling the mouse wheel after clicking inside the axial 
window, or clicking and dragging the line will change the cross section seen in the sagittal view as the line rotates 
about the axis of  the implant. Asymmetrical (STL) implants can be rotated about the long axis in this view (see 
the next section). 

Sagittal Section: Middle left window. This section is the view from the side of  the implant. The A-B line 
passing through the implant creates the cross-section view that appears in the axial view and is set by default to 
be positioned at the level of  the implant emergence point. Scrolling the mouse wheel after clicking inside the 
sagittal window, or clicking and dragging the line will change the cross section seen in the axial view. The implant 
widget in this view allows for quick resizing of  implant length and diameter (see the next section). 

Density Profile: Lower left window. Displays a real-time visualization of  the volume density immediately 
surrounding the implant. 

Volume Rendering: Right window. This frame allows user to change the implant position and orientation with 
the orientation widget within the 3D volume rendering. 

 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problem with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 
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Implant: View Preset Setup 

Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup. These presets may also be modified in the Restoration Tab. 

 

• Edit Name: Click on any preset to select it. 
Type the new name into the field. 

• Visibility checkboxes hide or show features in 
the rendering window. 

• Implant Profile: Controls the visibility of  
the solid implant cross section in the 2D 
renderers. When activated, the currently 
selected implant will have a red profile and 
the unselected implants will have blue 
profiles. When not activated, the selected 
implant will show an opaque cross section of  
the implant and the unselected implants will 
show as blue profiles. 

• Abutment: Controls the visibility of  the abutment 3D model in the volume renderer or the colored 
profile in the 2D slice renderers. 

• Waxup: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. 
Option is only available after they have been added by an Anatomage technician as part of  a surgical 
guide case workup.  

• Long Axis: Displays a colored rod running through the long axis of  the implant in the volume render. 

• Surrounding: Displays the surrounding volume around an implant. The collision zone is determined by 
the allowance defined in the preferences. 

• Trajectory: Displays the simulated trajectory of  the implant during surgical placement. 

• Sleeve: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. Option 
is only available if  the mandibular and maxillary models are available as well as after the Check Sleeve 
action has been performed.  

• Nerve: Displays a 3D nerve in the volume render or a cross section of  the nerve in the 2D section 
renderers. 

• Angle: Controls the visibility of  the angle between the long axes of  adjacent implants as well as the 
angles of  the abutment for each implant. 

• Model: Controls the visibility of  the stone models. Varying degrees of  transparency can be obtained 
with the Opacity slider bar. 

• Restoration: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration 
associated with the selected implant will be red while the unselected restorations will be pink. Varying 
degrees of  transparency can be obtained with the Opacity slider bar. 

• Volume: Controls the visibility of  the volume render as well as the rendering type. 
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Implant: Model Visibility 

The  Model Visibility function will open the Model 
Object Settings dialog.  

• The “Mandible” and “Maxilla” checkboxes control all 
of  the model visibility options (except Profile Only 
and Density) and allow the user to turn off  the set of  
models for each jaw independently. Note: The visibility 
checkboxes in Model Object Settings will not always match the 
checked/unchecked status of  the visibility checkboxes in the 
Control Panel.) 

• The Stone Model and Waxups Opacity can be 
adjusted for both jaws. 

 

Implant: 3D Implant Widget 

The  3D implant widget is designed to optimize visibility in the 
renderer and provide a high level of  versatility in implant positioning. 
The linear, colored arrows can be dragged to reposition the implant 
transversely. The colored arrows only appear when the camera 
perspective is close to orthogonal. The implant may also be moved along 
these directions using the keyboard arrow keys. 

• The yellow arrow (not shown) is parallel to the A-B line. 

• The blue arrow is orthogonal to the green and yellow arrows. 

• The green arrow runs through the long axis of  the implant. 

• The rotation circle appears on the same plane as the two arrows that 
are close to orthogonal to each other and to the camera perspective 
and features eight handles for rotation. 

 

Implant: 2D Implant Widget 

The 2D implant widget is designed to optimize visibility in the slice 
renderer and still provide a high level of  versatility in implant positioning 
as well as sizing. The implant may also be moved along its long axis or 
orthogonally with the keyboard arrow keys. 

• The rotation circle has eight handles for implant rotation along the 
same plane as the currently displayed slice. 

• The two red handles can be selected and dragged toward/away the 
implant to reduce/expand the diameter of  the implant sequentially 
through any available options for that implant model. 

• The two blue handles can be selected and dragged toward/away the 
implant to reduce/expand the length of  the implant sequentially 
through any available options for that implant model. 

• The implant model itself  can be selected and dragged in any direction 
along the same plane as the currently displayed slice. 

• A rotation circle appears when the product cross section is selected 
that allows for implant rotation about the long axis of  asymmetrical 
(STL) implants in the top left section renderer. Please contact 
Anatomage for an updated list of  asymmetrical (STL) implants. 
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Implant: 3D Implant Planning 
 

• In the View Control, click the Add Single Implant button.   

• The implant ID dialog will show up (image below). 

• Select implant ID to be inserted. Press OK, and a new implant will appear on the mouse pointer. 

• Drag and drop the implant in 3D view onto the surgical site. (It helps to have the volume rotated so that the 
surgical site is centered). 

• In axial view, align the yellow line such that the below cross-section view becomes the view along mesiodistal 
direction. 

• In cross-section view, re-orient and position the implant so that its angle is as desired. 

• In axial view, align the yellow line such that the cross-section view becomes the view along buccolingual 
direction. 

• In cross-section view, re-orient and position the implant so that its angle is as desired. 

• Review the final implant position in 3D view. 

o To delete an implant, select the desired implant in the 3D view and press the “delete” key on the 
keyboard.  The implant will be removed. 

 

A similar procedure can be done to add anchor pins to your 3D volume.  Select which anchor pin you would like 
to add and follow similar steps for adjusting its position. 
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Implant: Pano Implant Planning 

 

• Select Planning Layout: Pano Implant under 
the View Controls in the Implant Tab. 

• Rendering window updates to pano view (left) 

• Adjust the ArchSection focal trough such that 
the middle profile passes through the 
dentition. 

• Drag implant to its desired location and adjust 
the angle of  the implant. 

• Click to select implants and manipulate them 
in the cross sections. 

• Click the nodes above the implant identification numbers and connect them with other implants to 
create parallel implant groups. Remove the implants from these groups by clicking on the nodes again. 

• Repeat for all desired implants. 

• Select Planning Layout: 3D Implant to exit Pano-Mode and further adjust individual implants. 
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Implant: Bone Graft Simulation 

• Select the implant that requires a bone graft and click the Visualize bone graft volume tool . 

• The graft simulation tool will appear as an arc that moves along the central axis of  the implant in the 
cross section. 

• Click to place the graft in the desired position. 

• The resulting graft will appear in the 2D sections in blue and in the volume rendering in off-white. 

• The volume of  the graft will be displayed in the volume rendering. 

• The graft can be deleted by clicking on it to select it and pressing the “delete” key on the keyboard. 
 

  

 

 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The software measurement 
tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value depends on threshold 
values; thus, user must set proper thresholds to get the best estimate of  the desired structure. The measurements must not be used 
as the sole metric for any treatment. 

   

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the hardware scanner 
that generated the image data. The measurement cannot be more precise than the resolution of  the image. Software reports the 
value based on user-picked points. Due to the nature of  medical imaging, the boundary is not always well defined. The apparent 
boundary depends on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to 
brightness and contrast. The user must understand the limitation of  the measurement value before applying to the patient. If  you 
notice any inconsistencies or software problems with measurements, or have further questions or concerns about using 
measurement tools correctly, please contact us at (408) 885-1474 or email us at info@anatomage.com 
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Implant: Restoration Design 

While InvivoLight does not offer the advanced restoration capabilities of  the full Invivo5 software, a case with 
restorations already placed can be opened. The restorations will be visible, but manipulating them is limited to 
locking the restoration to the implant and moving the implant with the restoration.  
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Implant: Check Sleeve 

 

The  Check Sleeves function can be performed to determine the position of  where sleeves would be if  a 
surgical guide was produced for implant placement. This function will simulate possible collisions that may occur 
between: 

• Sleeves and other sleeves 

• Sleeves and the instrument 

• Sleeves and the stone model 

• Instrument and the stone model 
Interference: Demonstrated visually by a dark red colored sphere. These interference indicators are not 
updated in real-time and will only be rechecked after each instance that Check Sleeve is performed.  
 

 
Check Sleeve Interference: The user can 
change certain preferences to better simulate 
the actual procedure that will be performed, 
such as sleeve system, instrument, sleeve size, 
and drill. Solution options are to change 
implant planning, change sleeve preferences, 
or to allow a technician to try to resolve the 
interference. 

 

The option to check sleeves will automatically appear when attempting to save Anatomage Surgical Guide 
planning files. 



I N V I V O L I G H T 5 . 4
®
 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

 

ANA003 Rev D.  14 June 2017                                           Page 47 of 61                                      UM-INVL-ENG-54D 

Implant: Settings and Preferences 

Selecting the Preferences tool   opens up a customization window within the Implant Tab: 

 

Tooth ID System: 

You can set the ID to either the Universal or FDI(International) standard. 

Clipping Preference: 

Options for which models to include in volume clipping. 

Show Collision Warning: 

You can define whether or not to display a proximity warning between implants at an allowed tolerance. 

Rendering Method: 

Choose which rendering method (Default, Performance, and Quality) you would like to use in the Implant 
View Tab. 

Color Control: 

Set the various colors for the abutment, restoration, and collision colors. 

Detailed Implant Settings: 

Adjust default settings for individual implants. See more information below. 

Preferred Implants Settings: 

Used to modify which implants will be displayed in the drop-down menus in the Control Panel. See more 
information in the Preferred Implant Settings section on page 48. 
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Detailed Implant Settings 

When you select Detailed Implant Settings, you are able to adjust the default settings for individual implants in the 
Implant Planning Preference Window. 

 

 
Clicking once anywhere in the 
region above will activate drop-
down menus for the various 
implant characteristics. Options 
will not appear for implants not in the 
preferred list (see below).  

 

Click OK to save these preferences and the designated implant will be selected automatically when choosing a tooth in 
the Add Single Implant menu. 

 

Preferred Implants Settings 

The user can hide certain implants from populating the lists to simplify the drop-down menus. By default, all 
implant manufacturers and types are selected as “preferred.” To remove an implant, select it in the list on the 
right-hand side and use the left arrow button to remove it from the list.  

 

Settings will take effect in the 
drop-down menu options for 
Detailed Implant Settings as well 
as in the Implant section of  the 
Control Panel. If  there is a case 
open with implants that are not in 
the preferred list, the implant will 
still show up correctly in the 
renderers and the Control Panel. 
However, the specific settings for 
this implant cannot be changed 
and implants of  the same type 
cannot be added. 

Adding implants to the preferred list can be accomplished by selecting the implant manufacturer on the list on the 
left-hand side, selecting the specific product in the middle column, and pushing the right arrow button to add. 

 



I N V I V O L I G H T 5 . 4
®
 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

 

ANA003 Rev D.  14 June 2017                                           Page 49 of 61                                      UM-INVL-ENG-54D 

Density Profile Control 

By selecting the Density Profile Control icon    you can adjust the settings for the Density Profile. 

 

 

Visible: Toggles the visibility between the Density Profile and the 
third cross section. 

H.U.: Shows the bone density in Hounsfield units. 

Bone Density: Shows the density in Misch’s bone density units. 

Thickness: Changes the sampled volume located around the 
implant. 

Apical Space: Changes the sampled volume located at the apex of  
the implant. 

Cell Size: Changes how finely the voxels will be sampled and 
displayed in the volume around the implant. 

 

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well defined. The appeared boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must 
understand the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or 
software problems with measurements, or have further questions or concerns about using measurement tools correctly, 
please contact us at (408) 885-1474 or email us at info@anatomage.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problem with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 
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Gallery View Features 
 
 
In the Gallery View Tab you can retrieve images that have been captured.  Additionally, images can be imported into InvivoLight 
or exported to the location of  your choice.  Comments or notes can be added to describe images that have been captured. 
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Gallery: Toolbar 

Shown below is the Toolbar and tools that are loaded with the Gallery View Tab: 

 

 
Crop Image: Allows you to crop and save the image that was captured. 

 

Gallery: Control Panel 

 

Images: Gives a list of  all captured images.   

• Each of  these images has a “Name” and “Type” which can be 
renamed by double-clicking on the text. 

• Move Up/Down: Moves the selected image up or down on the list. 

• Crop Current: Allows you to crop the currently selected image 
within InvivoLight. 

Image Operation 

• All/Selected: Applies operation to all or a subset of  the images from 
the list. 

• Remove: Removes images from the Gallery. 

• Export: Allows you to export the images in the Image List to a path 
specified in the dialog box that opens. Files can be saved as one of  
the following formats: .jpg, .bmp, or .png. 

• Email: Captures all images to your email ready to send. This 
requires having a mailer client set up. 

Import Images: 

• Select to import images (.jpg, .bmp, .png) from an external source 
into the Gallery Tab. 

• Using this, you can import patient photographs into the InvivoLight 
software for storage within the Invivo file once saved. 

Comments: 

• Text box displays comments about the image displayed in the 
Rendering Window. 

• Add or change comments by clicking Edit at the bottom of  the 
Comment Box. 

2D Image Options: 

• Controls settings for 2D images. See more information in Gallery: 
2D Image Options. 
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Gallery: Rendering Window 

This window allows the viewing of  captured and imported images. The Gallery is particularly useful for creating a 
workup of  a particular case. Remember that the Gallery’s images will only be saved if  you re-save the whole file, 
otherwise any images captured will be lost. 

 

 
 

Please refer to Image Navigation (pg. 23) for information about controlling 

and adjusting these images. 
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Gallery: Adding Images to the Gallery 

Capture any single image to the Gallery. A single image within any view can be captured without including 
the other parts of  the rendering window. When the Capture to Gallery function is used, a dialog will appear 
on the screen providing the user with options regarding which parts of  the rendering window to capture.  
 
The options provided by each dialog will vary according to which InvivoLight view is currently displayed; 
the following example is the dialog that appears within the ArchSection Tab: 
 

Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

• Whole View – Captures a screenshot of  
the rendering window 

• Axial – Captures the axial slice view and 
no other parts of  the rendering window 

• Pano – Captures the pano view and no 
other parts of  the rendering window 

• Cross Sections – Captures a series of  
slices that are within the rendering 
window 

 
 
Options within each Select Image to Capture Dialog: 

Note: Some options will appear  gray (disabled) in the Select Image to Capture dialog. The choices available 
are determined by the specific layout as well as the view tab. 

 

ArchSection  Whole View 

 Axial 

  

 Pano 

 Cross Sections 

Implant  Whole View 

 Main Volume 

 Axial 

 Cross 

 Density 
 
 
 

 Para Arch 

 Pano 

 Arch Volume 

 Front Volume 
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Capture to Gallery Dialog: 

 

 

 Name: Image label 

Note: Image name must be unique from any 

other captured image in the Gallery and 

must not contain any special characters. 

 Type: Image type – can be set from 

the drop-down to “Captured” or 

“Photo.” 

 Comments: Additional comments 

about the image can be added in this 

section. 
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Gallery: 2D Image Options 

The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image 
format better.  

Opening 2D DICOM 

When instructed to open a 2D DICOM image, InvivoLight will automatically enter a mode that disables 
3D functionality. Only the Gallery Tab will be available within the software and the DICOM will appear 
as a Gallery image. 
 
If  a 2D DICOM is associated with a 3D volume as a scout image, opening the volume will automatically 
import that scout image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the 
option to adjust several settings such as Gray Scale 
Threshold, Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always 
reflect the updated settings when the image is selected 
in the Gallery and also after it has been 
saved/exported and then opened/imported back into 
InvivoLight.    
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of  
the above formats when using the Export… button. 
When saving individual Gallery images to file, the 
following image formats will be available (JPG, PNG, 
BMP).  
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Common How To Tasks 

How to Trace a Nerve 

• Go to the ArchSection Tab. 

• Make sure the pano is in Slice Mode (not X-ray mode). 

• Adjust focal trough such that the nerve pathway is visible in pano image. 

• Move cursor to the pano image. 

• Review the nerve pathway while using the scroll wheel.  

• If  the nerve is not clearly visible, scroll the mouse wheel. 

• If  the nerve is not clearly visible, adjust the focal trough. 

• When the nerve pathway is identified through the pano image, press New Nerve in the Control 

Panel. 

• Starting from the mandibular foramen, click point by point. 

• If  nerve is not clearly visible, use the scroll wheel to find the nerve and continue picking points. 

• Near mental foramen, move the mouse to cross-section view. 

• Use the scroll wheel to find the exit of  the nerve. 

• Pick points connecting the nerve exit. 

• Press Done in the Control Panel to finish the nerve. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software 
problem with nerve tracing or have further questions or concerns about nerve tracing, please contact Anatomage 
support at (408) 885-1474 or email us at info@anatomage.com 

 
 
 



I N V I V O L I G H T 5 . 4
®
 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

 

ANA003 Rev D.  14 June 2017                                           Page 57 of 61                                      UM-INVL-ENG-54D 

InvivoLight Software Troubleshooting 
Category Error Solution 

General Error Message: 

InvivoLight Application has encountered a problem and needs to close. We are sorry 
for the inconvenience. 

Click the “Don't Send” Button. 
Launch InvivoLight application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Cannot launch InvivoLight Open Task Manager and check if  multiple instances of  
InvivoLight is already running. 
Close other InvivoLight processes. 
Launch InvivoLight application again. 

Computer failure Launch InvivoLight application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Installation Error Message: 

Server is not Responding 

Check Internet connection. 
If  Internet is connected, try again later. 

Error Message: 

Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 

Failed to verify the license code! 

Check the license code and try again. 

Check internet connection and try again. 

Error Message: 

Wrong License Code! 

Check the license code and try again. 

Error Message: 

Invalid Authorization code 

Check the license code and try again. 

Error Message: 

Actual size of  the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 

 

File Operations Error Message: 

Failed to create process. Please close other applications and try again. 

Close all the other applications. 

Launch InvivoLight application again. 

Error Message: 

Error : Cannot read this file 

Check if  this file is supported by InvivoLight. 

Message: 

Not enough memory 

Close all the other applications. 

Launch InvivoLight application again. 

Error Message: 

Can't create temporary save file! 

Check if  the remaining disk capacity for the temporary 
folder is big enough. 

Error Message: 

Failed to read DICOM file! 

Check if  this file is supported by InvivoLight. 

Error Message: 

Can't read Dicom’s Image Data! 

Check if  this file is supported by InvivoLight. 

Try to open a file but nothing showing up Check if  this file is supported by InvivoLight. 

Error Message: 

Cannot save file! 

Check if  the file is the correct type. 

Check if  the file path is correct and folder is writable. 
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Image Rendering Error Message: 

Can't detect hardware acceleration for OpenGL support! 

Check if  the graphics card meets system requirements. 

Check if  the latest driver is installed for the graphics card. 

Image is distorted Switch to another view and switch back. 

Grayscale image shows up for all rendering presets Check if  the graphics card meets system requirements. 

Check if  the latest driver is installed for the graphics card. 

Warning Message: 

3D reconstruction may not work! 

Check if  the DICOM files are exported correctly. 

 
For all other issues, please contact Anatomage Inc. Customer Support at (408) 885-1474. 
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This comprehensive list provides a quick and easy way to find the relevant information that you would like to 
examine. 
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Submandibular .............................................................................................................................................................. 35 
Super Ceph .................................................................................................................................................................... 51 
Supramaxillary ............................................................................................................................................................... 35 
Thickness ....................................................................................................................................................................... 49 
Tool Bar .......................................................................................................................................................................... 11 
View Control ................................................................................................................................................................. 11 
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